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1. Wprowadzenie  

Niniejsza instrukcja jest skróconą wersją instrukcji do programu OpitM w języku 

angielskim dostępną na stronie internetowej przedmiotu „Optymalizacja Konstrukcji 

Lotniczych”. Głównym celem tego dokumentu jest przedstawienie sposobu instalacji 

oprogramowania, przygotowania biblioteki DLL oraz opis podstawowego postępowania 

z programem OptiM. 

Instrukcja ta jest przeznaczona głównie dla studentów zajęć projektowych z 

przedmiotu „Optymalizacja Konstrukcji Lotniczych” 
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2. OPTIM - instalacja 

2.1 Procedura instalacji OptiM 

Instalacja oprogramowania OptiM wiąże się z zainstalowaniem oprogramowania 

OpitiM (https://www.meil.pw.edu.pl/zsis/ZSiS/Dydaktyka/Oprogramowanie/OptiM) oraz z 

zainstalowania oprogramowania, które pozwoli na tworzenie bibliotek dołączanych 

dynamiczne tzw. bibliotek DLL. Zalecamy, aby do tworzenia tych bibliotek 

wykorzystywać oprogramowanie Dev-Cpp dostępne na 

(https://sourceforge.net/projects/orwelldevcpp/). Dev-Cpp to prostym i niezawodnym 

interfejsem, który niestety nie jest już rozwijany. Polecamy go, dlatego iż został on 

sprawdzony pod katem współpracy z programem OptiM. 

 

2.2 Instalacja kompilatora Dev-Cpp IDE 

Jeżeli użytkownik wybrał opcję instalacji Dev-Cpp, To należy go wstępnie 

skonfigurować. Po utworzeniu nowego projektu lub otwarciu jednego z przygotowanych 

przykładów (struktura katalogów przygotowanego do zadań opisane zostaną 

późniejszych rozdziałach) należy dostosować ustawienia kompilatora tak aby można 

byłby rozpocząć tworzenie biblioteki dynamicznej dla OptiM. Przede wszystkim należy, 

zdefiniować tzw. plik „makefile”. Najprostszym sposobem jest wskazanie pliku 

„makefile”, który zawarty jest materiałach przygotowanych do projektów. 

Aby to zrobić należy: z menu wybrać Projekt > „Project Options”. Następnie, wybrać 

kartę „Makefile”. Na karcie zaznaczć pole niestandardowego makefile’a i wybierz 

ścieżkę do makefile. Rys. 1. Plik makefile, w projektach przygotowanych na zajęcia 

zawarty jest w katalogu „Lib”.   

https://www.meil.pw.edu.pl/zsis/ZSiS/Dydaktyka/Oprogramowanie/OptiM
https://sourceforge.net/projects/orwelldevcpp/
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Rys. 1 Wybór pliku Makefile do projektu. 

 

2.3 Przygotowanie biblioteki DLL 

Przygotowanie biblioteki DLL można także zrealizować w wielu kompilatorach 

dostępnych w sieci. Jednak tak jak wspomniano zaleca się wykorzystanie programu 

Dev-C++ do przygotowania biblioteki ze względu na to iż została ona sprawdzona. 

Podstawowy kod biblioteki OptiM_Lib.cpp (nazwa może być dowolna) przedstawiony 

został na Rys. 2. Pierwsze linijki kodu zawierają definicje plików nagłówkowych 

standardowych bibliotek ale także definicje plików nagłówkowych bibliotek OptiM. 

Użytkownik może dodać także swoje definicje plików nagłówkowych. Następnie poniżej 

znajduje się definicja funkcji celu, która zawiera następujące parametry wejściowe: 

Numer bieżącej iteracji,  

• numer identyfikacyjny wątku (więcej szczegółów w instrukcji rozszerzonej)  

• struktura parametrów z OptiM (więcej szczegółów w instrukcji 

rozszerzonej) 

• wektor zmiennych niezależnych 

• wektor więzów/ograniczeń 

• wektor funkcji celu 
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Wewnątrz funkcji użytkownik definiuje funkcję celu. W celu poprawy efektywności 

pracy autor dodał plik nagłówkowy OptiM_Tools.h. Zawiera on wiele użytecznych funkcji 

algebraicznych. Ze względu na definicję struktury Param plik nagłówkowy 

OptiM_Tools.h musi być zawsze dołączany. 

#include <Param.h> 

#include <OptiM_Tools.h> 

#include “OptiM_Lib.h” 

 

using namespace std; 

 

double OBJ_F(int current_iter, int thread_id, Param *Par,  

 double *X, double *C, double *F) 

{      

    F[0] = 100*(X[1] - X[0]*X[0])*(X[1] - X[0]*X[0]) + (1-X[0])*(1-X[0]); 

    return F[0]; 

} 

 

Rys. 2 Podstawowy kod biblioteki OptiM_Lib.cpp 

 

Gdy kod biblioteki zastanie ukończony, należy skompilować bibliotekę za pomocą 

funkcji w programu DEV-C++ Execute > Compile lub użyć klawisza funkcyjnego F9. Po 

zakończeni kompilacji, w katalogu „Lib” pojawi się plik z rozszerzeniem *.dll. Następnie 

można rozpocząć już pracę z programem OptiM. 
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3. Podstawowa obsługa programu OptiM 

Po uruchomieniu programu pojawi się Główne okno programu (Rys. 3). W lewym 

górnym rogu okna dostępne jest Menu główne. To samo Menu jest dostępne po 

naciśnięcie prawego klawisza myszy. Większość komend posiada swoje skróty 

klawiszowe opisane w załączniku do tego dokumentu. Po kliknięciu w ikonkę w prawym 

dolnym rogu okna rozpoczyna się proces optymalizacji. W pasku tytułowym okna 

znajduje się nazwa wykorzystywanej do optymalizacji metody. W centralnej części okna 

wyświetlane są bieżące wyniki (zdefiniowane przez użytkownika). Dwa paski w dolnej 

części okna wskazują postęp procesu optymalizacji. 

 

Rys. 3 OptiM - okno główne 

 

W ramach menu głównego dostępne jest pięć następujących zakładek: 

• Zakładka „File” 

• Zakładka „Optimization” 

• Zakładka „Utilities” 

• Zakładka „Plot” 

• Zakładka „Help” 
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3.1 Zakładka „File’ 

W zakładce „File” znajdują się cztery następujące sekcje (Rys. 4). 

 

Rys. 4 Menu „File” 
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3.1.1 Zakładka File > VarEdit 

 

Sekcja VarEdit uruchamia podprogram VarEdit służący do edycji zmiennych 

niezależnych. Zostanie omówiony szczegółowo w Rozdziale 4 niniejszej instrukcji. 
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3.1.2 Zakładka File > Parameters 

 

W tej sekcji wyświetlane są wszystkie ustawienia zdefiniowane do programu OptiM 

(dane zawarte w pliku OptiM.om). Dotyczy to zarówno ustawień programu jak i ustawień 

poszczególnych metod optymalizacji. Plik OptiM.om jest też plikiem wykonywalnym, za 

pomocą którego można uruchomić program OptiM (z ustawieniami zawartymi w pliku).  

W tym miejscu należy przedstawić także typową strukturę katalogów, która 

wykorzystywana jest podczas pracy z programem OptiM. Na Rys. 5 przedstawiono tą 

strukturę katalogów składająca się z: 

• Katalog „Input” – zawiera pliki z danymi (plik o rozszerzeniu *.var) 

• Katalog „Lib” – zawiera pliki niezbędne do utworzenia biblioteki DLL, bibliotekę 

DLL oraz plik makefile 

• Katalog „Output” – pliki z wynikami obliczeń oraz logi. 

• Pliku wykonawczego o rozszerzeniem *.om (nazwa pliku zazwyczaj jest zgodna z 

naszą projektu) 

 

Rys. 5 Struktura katalogów w programie OptiM 

 

Rys. 6 przedstawia okno sekcji “Parameters”. Dane zawarty w tym oknie są 

odzwierciedleniem danych zapisanych w pliku *.om. Opis funkcji znajduje się w 

poniższej tabeli. 
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Rys. 6 Okno sekcji Parameters. 

OK zamyka okno „Parameters” (bez zapisywania) 

Load Parameters ładuje dane z pliku plik OptiM .om ze wskazanej lokalizacji 

Save Parameters zapisuje bieżące ustawienia do pliku o rozszerzeniu *.om 

Update OptiM.om zapisuje lub nadpisuje plik OptiM.om Uwaga! Program nie 

ostrzega użytkownika przed nadpisaniem pliku. 
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3.1.3 Zakładka File > Data Format 

 

W sekcji tej (Rys. 7) znajdują się ustawienia dotyczące formatu danych wyświetlanych 

oraz zapisywanych w plikach wynikowych, zdefiniowane przez użytkownika.  

 

Rys. 7 Okno do formatowania danych. 

 

Opis funkcji sekcji „Data Format” przedstawiony jest w poniższej tabeli. 

On Screen ustawienie wyświetlania zmiennych na ekranie tj: zmiennych 

projektowych, funkcji celu, ograniczeń, sumy ograniczeń, 

pochodnych oraz sumy pochodnych 

Format on screen format danych wyświetlanych w oknie. Całkowita liczba cyfr oraz 

cyfr po przecinku  

Format to file format danych wyświetlanych do pliku. Całkowita liczba cyfr oraz 

cyfr po przecinku 

Separator in file format separatorów zastosowanych w zapisie do pliku. Do 

wyboru jest liczba spacji lub tabulator 
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3.1.4 Zakładka File > Parallel 

 

W sekcji tej znajdują się ustawienia do obliczeń równoległych. Algorytmu 

optymalizacyjne, które analizują dane w grupach mogą wykorzystywać obliczenia 

równoległe. Obecne obliczenia równoległe wykorzystują następujące metody: 

• Monte Carlo 

• Genetic Algorithm 

• Particle Swarm Optimization (PSO) - Swarming 

 

Domyślnie program odnajduje całkowita dostępną liczbę rdzeni ale użytkownik może 

zmianie te ustawienia. Obliczenia mogą być wyłączone poprzez odznaczenie flagi w 

oknie obliczeń równoległych Rys. 8 

 

Rys. 8 Okna do ustawienia obliczeń równoległych 
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3.1.5 Zakładka File > Exit 

 

Zakończenie działania programu. 
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3.2 Zakładka „Optimization” 

W zakładce „Optimization” znajdują się następujące elementy (Rys. 9). Uwaga, 

kilka z prezentowanych opcji ma zdefiniowane dodatkowe submenu. 

 

Rys. 9 Zakładka “Optimization” 
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3.2.1 Zakładka Optimization > File paths 

 

Sekcja ta zawiera definicję ścieżek dostępu do katalogów projektu. Struktura 

katalogów przedstawiona została już w rozdziale 3.1.2 

W okienku (Rys. 10) użytkownik definiuje ścieżki dostępu do podstawowych plików 

programu OptiM. Każdą ścieżkę można zdefiniować za pomocą przycisku Browse lub 

samodzielnie wpisać. Opis zdefiniowanych ścieżek zostały przedstawione w poniższej 

tabeli. 

 

Rys. 10 Okno definicji ścieżek dostępu 

 

WorkDir definicja nazwy i położenia głównego katalogu projektu. 

Lib definicja ścieżki dostępu do katalogu zawierającego bibliotekę DLL, 

Zazwyczaj jest to podkatalog „Lib”. Plik o rozszerzeniu *.dll 

X Limit definicja ścieżki dostępu do katalogu zawierającego plik definiujący 

zakresy zmiennych niezależnych (minimum i maksimum). Plik o Zazwyczaj 

jest to podkatalog „Output”. 

Solution definicja ścieżki dostępu do katalogu zawierającego plik z historią procesu 

optymalizacji. Zazwyczaj jest to podkatalog „Output”. Rozszerzenie pliku 

*.txt 
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Log definicja ścieżki dostępu do podkatalogu zawierającego plik typu „log”. 

Zawierający szczegółowe informacje na temat całego procesu 

optymalizacji. Plik bardzo użyteczny w procesie analizy błędów 

powstających procesie optymalizacji. Plik o rozszerzeniu *.log. Zazwyczaj 

jest to podkatalog „Output” 

Pareto  definicja ścieżki dostępu do katalogu zawierającego plik zawierający 

rozszerzone informacje na temat analiz przeprowadzanych w trakcie 

optymalizacji. Dane wykorzystywane do tworzenia tzw. „Patero Front”  

 

Rys. 11 przedstawia przykładowe okno z definiowanymi ścieżkami dostępu. 

 

Rys. 11 Przykładowe okno ze ścieżkami dostępu 

 

W przykładowym oknie ze ścieżkami dostępu widać: 

• WorkDir: – pełna ścieżka dostępu do projektu o nazwie: „1_Paraboloid” 

• W pozostałych przypadkach niepełne względne ścieżki bazujące na definicji 

katalogu głównego projektu 

• Można podawać pełne ścieżki dostępu 
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3.2.2 Zakładka Optimization > Initialize 

 

Sekcja ta zawiera wstępne ustawienia do optymalizacji (Rys. 12).  

 

Rys. 12 Okno inicjalizacji obliczeń 

Opis w poniższej tabeli 

Iteration Limit limit iteracji, po której proces optymalizacji się zatrzyma, 

Number of X liczba zmiennych niezależnych/projektowych 

Random/Uniform metodologia tworzenie/generowania zmiennych w algorytmach 

zawierających definicję populacji (Np.: Algorytmy genetyczne). 

Wartości zmiennych są wybierane losowo lub równomiernie 

rozmieszczone między Xmin, Xmax.  

Number of C liczba zdefiniowanych ograniczeń 

μ współczynnik wykorzystywany w funkcji kary 

Number of F  liczba zdefiniowanych funkcji celu 

Initialize Fo Flaga sygnalizująca wykorzystanie wartośći początkowej funkcji 

celu 

Fo Wartość funkcji celu wykorzystana gdy flaga inicjalizująca została 

włączona 

OK zatwierdzenie zmian i zamkniecie okna 

Cancel zamyka okno bez zapisywania zmian 
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3.2.3 Zakładka Optimization > Solver 

 

Wybór metody optymalizacji przedstawiony została na Rys. 13. 

 

Rys. 13 Wybór metody optymalizacji 

 

Pierwszą zdefiniowaną metodą tzw. Tester to metoda która wyznacza wartość funkcji 

celu w pojedynczym punkcie. W ten sposób weryfikowana jest poprawność 

przygotowania biblioteki DLL. Wartość funkcji celu wyznaczana jest dokładnie dla 

średniej arytmetycznej założonych wartości minimalnej i maksymalnej dla wszystkich 

zdefiniowanych zmiennych niezależnych. Podczas procesu optymalizacji funkcja celu 

jest wywoływana dokładnie w taki sam sposób jak w przypadku metody „Tester”. W 

ramach wyboru dostępne są następujące metody: 

• Tester 

• Annealing 

• Hooke Jeeves 

• Powell 

• Nelder Mead 

• Gradient 
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• Monte Carlo  

• Genetic 

• Swarming 

Szczegóły metod oraz podstawy teoretyczne przedstawione zostały w rozszerzonej 

instrukcji do programy (w języku Angielskim). 
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3.2.4 Zakładka Optimization > Annealing 

 

Sekcja ta zawiera ustawienia do metody Annealing (Rys. 14). Szczegóły metody w 

pełnej instrukcji do OptiM. 

 

Rys. 14 Okno ustawień metody Annealing 

Opis opcji przedstawionych na w poniższej tabeli. 

 

Temperature sztuczna temperatura (szczegóły metody w Pełnej instrukcji do OptiM) 

CoolingRate parametr metody (szczegóły metody w Pełnej instrukcji do OptiM) 

Resolution parametr relaksacji (szczegóły metody w Pełnej instrukcji do OptiM) 

Scale dF parametr metody (szczegóły metody w Pełnej instrukcji do OptiM) 

dFmin  minimalna wartość zmiany funkcji celu Jeżeli różnica jest mniejsza 

stała wartość pochodnej jest wykorzystywana. 
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3.2.5 Zakładka Optimization > HookeJeeves 

Ustawienia do metody Hooke-Jeeves (Rys. 15). Szczegóły metody w pełnej 

instrukcji do OptiM. 

 

Rys. 15 Okno ustawień metody HookJeeves 

Opis w poniższej tabeli 

dV wstępna wartość kroku (prędkości zmian) 

Increment Step stała opisująca przyrost kroku w przypadku pozytywnej oceny 

wartości funkcji celu w poprzedniej iteracji. 

Reduction Step stała wykorzystywana do redukcji kroku w przypadku negatywnej 

oceny funkcji celu w poprzednim kroku.  
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3.2.6 Zakładka Optimization > Powell 

Sekcja ta zawiera ustawienia do metody Powell’a (Rys. 16). Szczegóły metody w 

pełnej instrukcji do OptiM. 

 

Rys. 16 Okno ustawień dla metody Powell’a 

 

Opis opcji w poniższej tabeli 

Direction Iterations maksymalna liczba iteracji w procesie optymalizacji 

Alfa Step Iterations maksymalna liczba iteracji przy poszukiwaniu parametru Alfa  

Increment Step stała wykorzystywana do zwiększenia kroku w przypadku 

powodzenia optymalizacji w poprzednim kroku  

Reduction Step stała wykorzystywana do redukcji kroku w przypadku 

niepowodzenia optymalizacji w poprzednim kroku  
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3.2.7 Zakładka Optimization > NelderMead 

Sekcja ta zawiera ustawienia do metody NelderMead (Rys. 17) Szczegóły metody 

w pełnej instrukcji do OptiM. 

 

Rys. 17 Okno ustawień dla metody NelderMead 

Opis opcji w poniższej tabeli: 

Reflection Stała używana do procedury reflekcji  

Expansion Stała używana do procedury ekspansji  

Contraction Stała używana do procedury kontrakcji  

Reduction Stała używana do procedury redukcji  
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3.2.8 Zakładka Optimization > Gradient 

Sekcja ta zawiera ustawienia dla całej grupy metod Gradientowych (Rys. 18). 

Dotyczy to parametrów związanych z poszukiwaniem kierunku - „Direction” i 

szacowaniem wartości parametru Alfa - „AlfaSearch”. Szczegóły metody dostępne są 

w pełnej instrukcji do OptiM. 

 

Rys. 18 Opcje ustawień metod gradientowych 

 

Zakładka Optimization > Gradient > Direction 

Menu „Direction”, w którym wybierana jest: 

• metoda wyznaczania gradientu, „Direction search solver”,  

• sposób wyznaczania pochodnej „Derivative”  

• definicja i sposób wykorzystania parametru kraoku Eps 
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Rys. 19 Okno ustawień dla metod gradientowych kierunkowych 

 

Opis opcji w poniższej tabeli 

Direction search solver Wybór metody gradientowej. Cztery metody są dostępne: 

Steepest Descent, Conjugate Gradient, Quasi Newton, 

Newton Method. Szczegóły prezentowanych metod w 

instrukcji 

Derivative Wybór metody wyznaczania pochodnej: jednostronnej i 

centralnej  

h kroku (szczegóły w pełnej instrukcji obsługi 

Eps Parametr kroku wykorzystany do wyznaczenia  

OK Akceptacja zmian i opuszczenia okna 

Cancel Opuszczenie okna bez akceptacji zmian 

 

Zakładka Optimization > Gradient > Alfa Search 

Sekcja ta zawira ….Okno w którym definiowane są parametry wyznaczania 

parametru alfa. Opis w poniższej tabeli 
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Rys. 20 Okno ustawień poszukiwania parametru Alfa 

Opis opcji w poniższej tabeli 

Alfa convexity criterion Krytrium wyznaczania parametru Alfa (szczegóły w Pełnej 

instrukcji do OptiM)  

Alfa iteration limit liczba iteracji do znalezienia odpowiedniego kroku, po jej 

przekroczeniu proces zatrzymuje się. Parametr ten nie 

powinien przekraczać 10  

Alfa min Jeżeli w procesie optymalizacji parametr Alfa będzie 

mniejszy niż Alfa min to proces zostanie zatrzymany 

Alfa low Najmniejsza wartość parametru Alfa, wartości ta powinna być 

wystarczająco niska aby uzyskać dobrą dokładność, musi 

byś też większa niż wartość Alfa min  

Alfa high początkowa wartość parametru. Alfa Wartość domyślna 1 

Alfa  

c1 współczynnik c1 (szczegóły w Pełnej instrukcji do programu 

OptiM), typowa wartość to 0,1  

c2 współczynnik c2 (szczegóły w Pełnej instrukcji do programu 

OptiM), typowa wartość to 0,9  

u Współczynnik do określania wrażliwości parametru Alfa 

(szczegóły w Pełnej instrukcji do programu OptiM) 
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3.2.9 Zakładka Optimization > Monte Carlo 

Sekcja ta zawiera ustawienia do metody „Monte Carlo”. Użytkownik ustawia liczbę 

próbek ocenianych podczas każdej iteracji. Rozdzielczość określa, ile części każda 

zmienna jest podzielona między ustawione limity. Podczas każdej iteracji limity 

zmniejszają się proporcjonalnie do współczynnika promienia. Im większy współczynnik, 

tym bardziej prawdopodobne jest znalezienie globalnego optimum, ale optymalizacja 

trwa dłużej. Szczegóły metody w pełnej instrukcji do OptiM 

 

Rys. 21 Okno ustawień metody Monte Carlo 

 

Opis opcji w poniższej tabeli 

Samples Liczba próbek przygotowanych do obliczeń w pojedynczej iteracji. 

Obliczenia mogą być wykonywane równolegle. 

Resolution Rozdzielczości – dokładność wyznaczana na podstawie podziału 

zakresu Xmin i Xmax. 

Radius Współczynnik redukcji zakresu (szczegóły w pełnej instrukcji) 
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3.2.10 Zakładka Optimization > Genetic 

Sekcja ta zawiera ustawienia dotyczące Algorytmów Genetycznych. W ramach 

dodatkowych ustawień można zdefiniować metody selekcji (Genetic Selection) oraz 

podstawowe ustawienia metody (szczegóły metody w pełnej instrukcji do OptiM)  

 

Rys. 22 Sekcja Genetic 

 

Zakładka Optimization > Genetic > Genetic Selection 

Sekcja ta zawiera globalne ustawienia dla algorytmów genetycznych (Rys. 23).  

 

Rys. 23 Okno ustawień dla metod Genetycznych 
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Opis opcji znajduje się w poniższej tabeli. 

Population rozmiar populacji. 

Genes length liczba genów 

Resolution rozdzielczość / dokładność  

MOM Weight definicja „Measure of Merit - MOM” (szczegóły w Pełnej 

instrukcji do programu OptiM) 

Cos() Power dodatkowy parametr (szczegóły w Pełnej instrukcji do 

programu OptiM) 

GA Selection Strategy wybór strategii selekcji (szczegóły w Pełnej instrukcji do 

programu OptiM) 

BreederPoolElit Dodatkowy parametr do metody selekcji typu BreederPool  
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Zakładka Optimization > Genetic > Genetic Methods 

Wybór parametrów i ustawień dla reprodukcji ().  

 

Rys. 24 Okno ustawień metod genetycznych – reprodukcja 

 

Opis w poniższej tabeli. 

Cross Over Parametry metody Cross Over (szczegóły w Pełnej instrukcji do 

programu OpitM) 

Mutation Factor Wybór wyznaczania współczynnika mutacji – automatycznie lub 

przez użytkownika (szczegóły w Pełnej instrukcji do programu 

OpitM) 

Mutation % Jeżeli założono mutację wyznaczana przez użytkownika to ten 

parametr definiuje jak duża część genomu (w %) podlega mutacji 

(szczegóły w Pełnej Instrukcji do programu OptiM) 
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3.2.11 Zakładka Optimization > Swarming 

Sekcja ta zawiera ustawienia do metody Swarming (metoda roju) (Rys. 25). Szczegóły 

metody zawarte są w pełnej instrukcji do OptiM  

 

Rys. 25 Okno metody Swarming 

 

Opis parametrów w tabeli poniżej. 

Particles liczba cząstek w roju podlegająca analizie (szczegóły w Pełnej Instrukcji 

do programu OpitM) 

Resolution liczba elementów (szczegóły w Pełnej Instrukcji do programu OpitM)  

w Współczynnik skalowania globalnego wektora prędkości (szczegóły w 

Pełnej Instrukcji do programu OpitM) 

s1 Współczynnik skalowania najlepszej pozycji cząstek (szczegóły w 

Pełnej Instrukcji do programu OpitM) 

s2 Współczynnik skali najlepszej cząstki (szczegóły w Pełnej Instrukcji do 

programu OpitM)  
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3.2.12 Zakładka Optimization > Stop Criterion 

Sekcja ta definiuje się warunki zatrzymania procesu optymalizacji tzw. kryterium stopu 

(Rys. 26). Użytkownik może zdefiniować parametry, które muszą być spełnione aby 

zatrzymać proces optymalizacji. Bez tego ograniczenia optymalizacja zakończy się po 

określonej liczbie iteracji określonych w warunkach początkowych. Szczegóły metody w 

pełnej instrukcji do OptiM 

 

Rys. 26 Okno Kryterium stopu 

Opis w poniższej tabeli. 

OBJ_F difference kryterium stopu gdy wartość funkcji celu jest mniejsza niż 

zdefiniowana 

Gradient sum  kryterium stopu gdy wartość sumy pochodnych jest mniejsza niż 

zdefiniowana. Teoretycznie, optimum powinno być osiągane gdy 

gradient funkcji jest równy zero. 

OBJ_F sig kryterium stopu gdy wartość funkcji celu jest mniejsza niż 

zdefiniowana Stops if standard deviation of objective function is 

below specified value 
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3.2.13 Zakładka Optimization > Flags 

 

Tzw. Flagi po parametry które przyjmują wartości 0 lub 1 i mają sygnalizować 

uruchomienie lub zatrzymanie działania funkcji. Flagi wykorzystywane do aktywacji lub 

dezaktywacji zmiennych niezależnych lub ograniczeń Aby aktywować flagi, pole wyboru 

powinno być włączone. Flagi są zdefiniowane przez ciąg „0” i „1”. Długość łańcucha 

powinna być równa liczbie zmiennych projektowych. 

 

X flags Flagi dla zmiennych niezależnych  

C flags Flagi dla zmiennych ograniczeń 

 

 

Rys. 27 Okno flag 
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3.3 Zakładka Utilities 

Zakładka Utilities zawiera następujące elementy (Rys. 28). 

 

Rys. 28 Zawartość zakładki “Utilities” 
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3.3.1 Zakładka Utilities > InitFromSol 

Plik z definicją zmiennych niezależnych *.var można tworzyć w oparciu o rozwiązania 

zapisane w pliku * .sol. Użytkownik może wybrać numer iteracji, z którego ma zostać 

utworzony plik * .var. Wartości minimalne i maksymalne będą równe. Jest to 

wystarczające w przypadku algorytmów optymalizacji kierunkowej, ale w przypadku 

innych algorytmów optymalizacji wartości minimalne i maksymalne powinny być różne. 

 

Rys. 29 Initialize from solution window. 

Opis opcji  

Number of Variables Liczba zmiennych niezależnych. 

Init from Numer iteracji na podstawie której tworzony jest plik *.var 

Sol file Nazwa pliku z rozwiązaniem 

Output Plik wyjściowy o rozszerzeniu *.var Output file *.var. 

 



                                                                                                                              OptiM Instrukcja Obsługi 

 - 39 - 

3.3.2 Utilities > Statistics 

To narzędzie umożliwia prostą analizę statystyczną metod generujących grupy 

punktów do optymalizacji. Pokazuje średnią wartość (µ) i odchylenie standardowe (σ) 

dla każdej zmiennej i funkcji celu w każdej iteracji. 

 

 

Rys. 30 Statistics window. 

 

Pareto data Plik o rozszerzeniu *.pareto 

Output Plik wyjściowy do analizy statystycznej. 
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3.3.3 Zakładka Utilities > MinMax 

W sekcji tej wyszukiwane sa maksymalne i minimalne wartości w funkcji iteracji dla 

każdej zmiennej niezależnej, dla każdego ograniczenia i dla każdej funkcji celu. 

 

 

Rys. 31 Okno definicji wartości minimalnej i maksymalnej. 

 

Pareto data Plik *.pareto  

Output Plik z wartościami opisującymi minimum i maksimum funkcji celu. 
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3.3.4 Zakładka Utilities > Norm 

W sekcji tej definiowanie są ustawienia dotyczące normalizacji wyników 

otrzymanych z procesu optymalizacji. Normalizacja odbywa się poprzez podzielenie 

wyników przez wartość średnią.  

 

 

Rys. 32 Okno do normalizacji wyników. 

Opis opcji przedstawiony jest w poniższej tabeli: 

Number of Variables  Liczba zmiennych niezależnych w procesie optymalizacji 

Iteration limit  Maksymalna liczba iteracji w pliku  

Sol file Plik z wynikami optymalizacji 

Output Plik zawierający znormalizowane wyniki 
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3.4 Zakładka Plot 

Zakładka „Plot” zawiera następujące dwa elementy (Rys. 33).  

 

Rys. 33 Zakładka “Plot” 

  

3.4.1 Zakładka Plot > Settings 

W sekcji tej znajdują się podstawowe ustawienia definiujące wyświetlanie wykresów 

w OptiM.  

 

Rys. 34 Plot settings window. 

Opis opcji w poniższej tabeli. 

Plot załącza wyświetlanie wykresu podczas procesu optymalizacji. 

Legend załącza wyświetlanie legendy. 

Grid załącza wyświetlanie siatki. 

Background zmiana koloru tła białe/czarne (White/Black). 
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3.4.2 Zakładka Plot > Data 

W sekcji tej definiowane są ustawienia wyświetlania wyników w postprocessingu, 

opartym na danych z pliku * .pareto. Szczegóły … 

 

Rys. 35 Plot Postprocessing window. 

 

Pareto file Nazwa pliku Pareto z danymi. 

Iter Definicja zakresu iteracji do wykorzystanymi do analizy. Nastęujące opcej 

sa dostępne: 

• All 

• Single+numer of the iteration 

• Fmin 

(szczegóły w Pełnej Instrukcji do programu OptiM) 

X axis Parametr dla osi X 

Y axis Parametr dla osi Y 

Set limits Definicja wartości minimalnych i maksymalnych dla osi wykresu. 
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3.5 Zakładka Help 

Zakładka „Help” zawiera trzy następujące elementy (Rys. 36). 

 

Rys. 36 Zakładka „Help” 

 

3.5.1 Zakładka Help > Manual 

Otwiera instrukcje obsługi programu OptiM (w języku angielskim) 

 

3.5.2 Zakładka Help > License 

Licencja OptiM. 

 

3.5.3 Zakładka Help > About 

Krótka informacja na temat wersji OptiM. 
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4 Instrukcja do podprogramu VAREDIT  

VarEdit to prosty program, Rys. 37, do definiowania zmiennych wejściowych, 

ograniczeń i opcji wyjściowych dla OptiM. Dane zapisywane są w pliku w formacie 

zwykłego tekstu z rozszerzeniem * .var (można je edytować ręcznie). Tabele zmiennych, 

ograniczeń i funkcji celu są ograniczone do 1000 wierszy.  

 

Rys. 37 Okno główne programu VarEdit. 

 

Następujące funkse  

 

File Plik konfiguracyjny o rozszerzeniu var, w którym zapisane są  wszystkie 
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dane programu.  

X nr Liczba zdefiniowanych zmiennych niezależnych. 

C nr Liczba definiowanych ograniczeń. 

F nr Liczba monitorowanych funkcji celu. 
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4.1 Zmienne niezależne 

Pola i przyciski u góry kolumn ustawiają wartości we wszystkich wierszach dla 

konkretnej kolumny. W przypadku algorytmu, który rozpoczyna optymalizację od 

pojedynczego punktu projektowego, na przykład metody gradientowej, wartości 

zmiennych są obliczane jako średnie z wartości Min i Max. Tę samą wartość można 

określić dla Min i Max. 

Id numer identyfikacyjny zmiennej (numer jest wykorzystywany w bibliotece 

DLL) 

Name nazwa zmiennej przedstawiana na wykresie I plikach wynikowych. 

Min wartość minimalna zmiennej 

Max wartość maksymalna zmiennej 

Active ustawia zmienną jako aktywną lub nieaktywną (czyli ulega zmianie lub 

pozostaje stała) 

Plot ustawia czy zmienna ma być wyświetlana na wykresie czy nie 

Range Ustawia czy wartości minimalna i maksymalna jest wartości stałą czy też 

nie. Niektóre algorytmu wymagają zmiany tych wartości. 

Comment Komentarz użytkownika do zmiennej – informacja opcjonalna 
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4.2 Więzy/Ograniczenia 

 

Pola i przyciski u góry kolumn ustawiają wartości we wszystkich wierszach dla 

konkretnej kolumny. 

Id numer identyfikacyjny ograniczenia (numer jest wykorzystywany w 

bibliotece DLL) 

Name nazwa ograniczenia przedstawiana na wykresie I plikach wynikowych. 

Gain wzmocnienie ograniczenia która określa jego „siłę” 

Active ustawia ograniczenia jako aktywne lub nieaktywne (czyli ulega zmianie lub 

pozostaje stała) 

Plot ustawia czy zmienna ma być wyświetlana na wykresie czy nie 

Comment Komentarz użytkownika do ograniczenia – informacja opcjonalna 
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4.3 Funkcja Celu 

Id numer identyfikacyjny funkcji celu (numer jest wykorzystywany w 

bibliotece DLL) 

Name nazwa ograniczenia przedstawiana na wykresie I plikach wynikowych. 

Plot ustawia czy zmienna ma być wyświetlana na wykresie czy nie 

Comment Komentarz użytkownika do funkcji celu – informacja opcjonalna 
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APPENDIX – Lista skrótów klawiszowych 

Zakładka File 

Parameters    Ctrl + P 

Data Format    Ctrl + D 

Parallel    Ctrl + L 

 

Zakładka Optimization 

File paths    Ctrl + O 

Initialize    Ctrl + I 

 

Solver 

 Tester    T 

 Annealing   1 

 HookJeeves   2 

Powell    3 

NelderMead   4 

Gradient   5 

 Monte Carlo   6 

 Genetic   7 

 Swarming   8 

 

Annealing    Shift + Ctrl + A 

HookJeeves    Shift + Ctrl + J 

Powell     Shift + Ctrl + W 

NelderMead    Shift + Ctrl + N 

 

Gradient 

 Direction   Shift + Ctrl + D 

 Alfa Search   Shift + Ctrl + F 

 

Monte Carlo    Shift + Ctrl + M 
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Genetic Algorithm 

 Genetic Selection  Shift + Ctrl + G 

 Genetic Methods  Shift + Ctrl + E 

 

Swarming    Shift + Ctrl + S 

Stop Criterion   Ctrl + C 

Flags     Ctrl + F 

 

Zakładka Help 

Manual    Ctrl + H  


